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The image is inserted in your Office document. Clip art and copyright The licensing filter Creative Commons
only or All can help you choose images that are appropriate for the use you have in mind. Read about Creative
Commons licenses here. Click a section title below to open it and read detailed instructions. On the Insert tab,
in the Add-ins group, select Store. The Office Add-ins dialog box opens. In the dialog box, use the Search box
to look for Pickit Free Images. Click the Add button for Pickit Free Images. Close the Office Add-ins dialog
box. Pickit may take a few moments to be "loaded" into the Office app. Find and insert images with Pickit
Once Pickit is on your computer, you can find pictures with it as described here: On the Home tab of the
Ribbon, in the Pickit section at the far right, select the Free Images button. The Pickit Free Images task panel
opens on the right side of the application window. On the pink toolbar near the top, use the second tab, the
Pickit market, to browse for images. Pickit lets you browse images in several ways: A set of featured
collections B just below the Search box. The set includes a Clip Art Characters collection. There are 25
collections C organized by Pickit. There are numerous user collections D to browse. There are 35 categories E
of images such animals and pets, cities and places, music and instruments, and transportation you can choose
from at the bottom of the task panel. Icons are ready-made images that you can insert, pivot, rotate, color, and
resize with no loss of quality. To read about icons, see Insert SVG images and icons. To read about these 3D
images, see Get creative with 3D models. On the Insert tab of the toolbar ribbon, in the Images section, select
Clip Art. The Clip Art task panel appears on the right side of the application window. Under Results should
be, select the types of media you want included in the search results: Select Go to start the search. The search
results are shown in the task panel. To insert a picture in your document, right-click the thumbnail image in
the task panel, and select Insert. Once the image is inserted, you can adjust its placement by selecting it and
dragging with the mouse. To better understand the licensing options, see Filter images by license type.
Beginning with version Filter the results by Type for Clipart.
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In general, all CPUs, single-chip microprocessors or multi-chip implementations run programs by performing
the following steps: Read an instruction and decode it Find any associated data that is needed to process the
instruction Process the instruction The instruction cycle is repeated continuously until the power is turned off.
Increasing execution speed[ edit ] Complicating this simple-looking series of steps is the fact that the memory
hierarchy, which includes caching , main memory and non-volatile storage like hard disks where the program
instructions and data reside , has always been slower than the processor itself. Step 2 often introduces a
lengthy in CPU terms delay while the data arrives over the computer bus. A considerable amount of research
has been put into designs that avoid these delays as much as possible. Over the years, a central goal was to
execute more instructions in parallel, thus increasing the effective execution speed of a program. These efforts
introduced complicated logic and circuit structures. Initially, these techniques could only be implemented on
expensive mainframes or supercomputers due to the amount of circuitry needed for these techniques. As
semiconductor manufacturing progressed, more and more of these techniques could be implemented on a
single semiconductor chip. Instruction set choice[ edit ] Instruction sets have shifted over the years, from
originally very simple to sometimes very complex in various respects. However, the choice of instruction set
architecture may greatly affect the complexity of implementing high-performance devices. The prominent
strategy, used to develop the first RISC processors, was to simplify instructions to a minimum of individual
semantic complexity combined with high encoding regularity and simplicity. Such uniform instructions were
easily fetched, decoded and executed in a pipelined fashion and a simple strategy to reduce the number of
logic levels in order to reach high operating frequencies; instruction cache-memories compensated for the
higher operating frequency and inherently low code density while large register sets were used to factor out as
much of the slow memory accesses as possible. Instruction pipelining One of the first, and most powerful,
techniques to improve performance is the use of instruction pipelining. Early processor designs would carry
out all of the steps above for one instruction before moving onto the next. Large portions of the circuitry were
left idle at any one step; for instance, the instruction decoding circuitry would be idle during execution and so
on. Pipelining improves performance by allowing a number of instructions to work their way through the
processor at the same time. In the same basic example, the processor would start to decode step 1 a new
instruction while the last one was waiting for results. This would allow up to four instructions to be "in flight"
at one time, making the processor look four times as fast. Although any one instruction takes just as long to
complete there are still four steps the CPU as a whole "retires" instructions much faster. RISC makes pipelines
smaller and much easier to construct by cleanly separating each stage of the instruction process and making
them take the same amount of timeâ€”one cycle. The processor as a whole operates in an assembly line
fashion, with instructions coming in one side and results out the other. Due to the reduced complexity of the
classic RISC pipeline , the pipelined core and an instruction cache could be placed on the same size die that
would otherwise fit the core alone on a CISC design. This was the real reason that RISC was faster. Pipelines
are by no means limited to RISC designs. Improvements in pipelining and caching are the two major
microarchitectural advances that have enabled processor performance to keep pace with the circuit technology
on which they are based. CPU cache It was not long before improvements in chip manufacturing allowed for
even more circuitry to be placed on the die, and designers started looking for ways to use it. One of the most
common was to add an ever-increasing amount of cache memory on-die. Cache is simply very fast memory. It
can be accessed in a few cycles as opposed to many needed to "talk" to main memory. The CPU includes a
cache controller which automates reading and writing from the cache. If the data is already in the cache it
simply "appears", whereas if it is not the processor is "stalled" while the cache controller reads it in. Generally
speaking, more cache means more performance, due to reduced stalling. Caches and pipelines were a perfect
match for each other. Using on-chip cache memory instead, meant that a pipeline could run at the speed of the
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cache access latency, a much smaller length of time. This allowed the operating frequencies of processors to
increase at a much faster rate than that of off-chip memory. Branch predictor One barrier to achieving higher
performance through instruction-level parallelism stems from pipeline stalls and flushes due to branches. As
clock speeds increase the depth of the pipeline increases with it, and some modern processors may have 20
stages or more. Techniques such as branch prediction and speculative execution are used to lessen these
branch penalties. Branch prediction is where the hardware makes educated guesses on whether a particular
branch will be taken. In reality one side or the other of the branch will be called much more often than the
other. Modern designs have rather complex statistical prediction systems, which watch the results of past
branches to predict the future with greater accuracy. The guess allows the hardware to prefetch instructions
without waiting for the register read. Speculative execution is a further enhancement in which the code along
the predicted path is not just prefetched but also executed before it is known whether the branch should be
taken or not. This can yield better performance when the guess is good, with the risk of a huge penalty when
the guess is bad because instructions need to be undone. Superscalar Even with all of the added complexity
and gates needed to support the concepts outlined above, improvements in semiconductor manufacturing soon
allowed even more logic gates to be used. In the outline above the processor processes parts of a single
instruction at a time. Computer programs could be executed faster if multiple instructions were processed
simultaneously. This is what superscalar processors achieve, by replicating functional units such as ALUs.
The replication of functional units was only made possible when the die area of a single-issue processor no
longer stretched the limits of what could be reliably manufactured. By the late s, superscalar designs started to
enter the market place. In modern designs it is common to find two load units, one store many instructions
have no results to store , two or more integer math units, two or more floating point units, and often a SIMD
unit of some sort. The instruction issue logic grows in complexity by reading in a huge list of instructions from
memory and handing them off to the different execution units that are idle at that point. The results are then
collected and re-ordered at the end. Out-of-order execution The addition of caches reduces the frequency or
duration of stalls due to waiting for data to be fetched from the memory hierarchy, but does not get rid of these
stalls entirely. In early designs a cache miss would force the cache controller to stall the processor and wait. Of
course there may be some other instruction in the program whose data is available in the cache at that point.
Out-of-order execution allows that ready instruction to be processed while an older instruction waits on the
cache, then re-orders the results to make it appear that everything happened in the programmed order. This
technique is also used to avoid other operand dependency stalls, such as an instruction awaiting a result from a
long latency floating-point operation or other multi-cycle operations. Register renaming Register renaming
refers to a technique used to avoid unnecessary serialized execution of program instructions because of the
reuse of the same registers by those instructions. Suppose we have two groups of instruction that will use the
same register. One set of instructions is executed first to leave the register to the other set, but if the other set is
assigned to a different similar register, both sets of instructions can be executed in parallel or in series.
Multiprocessing and multithreading[ edit ] Main articles: Multiprocessing and Multithreading computer
architecture Computer architects have become stymied by the growing mismatch in CPU operating
frequencies and DRAM access times. None of the techniques that exploited instruction-level parallelism ILP
within one program could make up for the long stalls that occurred when data had to be fetched from main
memory. Additionally, the large transistor counts and high operating frequencies needed for the more
advanced ILP techniques required power dissipation levels that could no longer be cheaply cooled. For these
reasons, newer generations of computers have started to exploit higher levels of parallelism that exist outside
of a single program or program thread. This trend is sometimes known as throughput computing. This idea
originated in the mainframe market where online transaction processing emphasized not just the execution
speed of one transaction, but the capacity to deal with massive numbers of transactions. With
transaction-based applications such as network routing and web-site serving greatly increasing in the last
decade, the computer industry has re-emphasized capacity and throughput issues. One technique of how this
parallelism is achieved is through multiprocessing systems, computer systems with multiple CPUs. Once
reserved for high-end mainframes and supercomputers , small-scale 2â€”8 multiprocessors servers have
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become commonplace for the small business market. For large corporations, large scale 16â€” multiprocessors
are common. Even personal computers with multiple CPUs have appeared since the s. With further transistor
size reductions made available with semiconductor technology advances, multi-core CPUs have appeared
where multiple CPUs are implemented on the same silicon chip. Initially used in chips targeting embedded
markets, where simpler and smaller CPUs would allow multiple instantiations to fit on one piece of silicon.
Another technique that has become more popular recently is multithreading. In multithreading, when the
processor has to fetch data from slow system memory, instead of stalling for the data to arrive, the processor
switches to another program or program thread which is ready to execute. Conceptually, multithreading is
equivalent to a context switch at the operating system level. The difference is that a multithreaded CPU can do
a thread switch in one CPU cycle instead of the hundreds or thousands of CPU cycles a context switch
normally requires. This is achieved by replicating the state hardware such as the register file and program
counter for each active thread. A further enhancement is simultaneous multithreading.
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View Photos Enjoying a bit of conversation over a beer is a pastime that goes back centuries, and today, new
iterations of the proverbial brewpub are popping up all over the world. Although this craft brewing
phenomenon has its roots in tradition, many of the microbreweries seen today are distinctly modern in terms
of their design and the techniques they employ. Read on to see 10 of our favorites. Mikkeller and Friends
Location: Copenhagen, Denmark Mikkeller has many locations, but the originals hail from Denmark. This tap
room in Copenhagen celebrates the very essence of Scandinavian design. They worked with designer Karsten
K. They custom-made the birch-plywood furniture and the wooden panels that cover the bar. Much of the
branding design was done in collaboration with Official Mfg. They designed various elements to help divide
up the space for eating, watching sports, or trying out their large selection of craft beers. The wall behind the
long and narrow bar offers 48 taps of different craft beers. Minneapolis, Minnesota This indoor industrial
biergartenâ€”which is located in a building that was formerly used by General Electric to manufacture light
bulbsâ€”is the perfect combination of a traditional beer hall and a modern meeting place. He framed original
elements of the building with simple forms while focusing on the power of its negative spaces. Mikkeller Bar
SF Location: Housed within the original bones of a year-old building, it features an open-plan bar that offers
40 taps of rare craft beers. Smokestack at Magnolia Brewing Company Location: San Francisco, California
Located in the historic Dogpatch neighborhood of San Francisco, Smokestack at Magnolia Brewing Company
transports its patrons to the Prohibition era with an architectural patina that works perfectly with its more
contemporary details and beer hall-style seating. Lublin, Poland Designed by Polish architecture firm, Projekt
Praga , the Perlowa Brew House in Lublin takes advantage of vertical space to give an otherwise narrow tap
room the illusion of volume. Oak lines the perimeter of the room, referencing the upward trajectory of the
space, and also lends a natural element to the hard metal and reflective facade of the bar. To fit the space, a
matching oblong light ring and mirror are stacked above the almost foot-long bar, reflecting the social scene
taking place below. The design team created a bar top made of zinc, which references traditional zinc counters
and equipment used in beer brewing. This artsy location certainly lives up to the colorful inspiration behind
the breweryâ€”Modern Times gets its namesake from a late 19th-century utopian community in New York.
Everything from the the wild decor to the names of their beers are directly inspired by this example of the
ideology.
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Rather than looking at seasonal, fleeting trends, FranklinTill focuses on longer-lasting movements that have
genuine impact on creative professionals. Keep it close by in the studio. The art of reduction As a reaction to
our participatory culture, in which we are always switched on, connected and increasingly overloaded with
data, designers are exploring new and simplified ways of refining and simplifying visual information. They
are experimenting with the art of reduction, discarding superfluous information and breaking down graphic
artwork and typographic information into their purist forms. Through his Exercise One project, Josep Roman
explores the reduction of information into the most nominal form. The publication forms a biography of the
Manchester band, Joy Division, a story filtered down to sophisticated infographic material, in which the line
becomes the leading protagonist. Reducing logos to their most simplistic form creates a solid and often
authoritative brand identity. For example, brand design agency The Consult has created a playful, yet stripped
bare, identity for London-based architectural practice stack. The effective monochrome identity visualises a
stacked logotype and graphic icon, drawing upon a childlike representation of the profession. A digital clock
display has been simply reduced to pixel form by Japanese design agency E-Bird. The 1pxclock is an iPhone
app conveying time ticking away one pixel per second. Hand-drawn As an antidote to highly-polished
perfection, the raw product of the human hand has become increasingly alluring. It sits in stark contrast to
slick digitally-produced graphic design. It started life as a reaction to the depersonalisation of email, texts and
tweets. Designers and creative thinkers were invited to send a handwritten note with comments relating to
their thoughts about the handwritten word. Another artist embracing this aesthetic is Jonathan Gray, who has
worked under the name Gray for the past 12 years. His distinctive hand-drawn type has graced the covers of
many books, the dramatic, painterly images resonating with the reader and drawing them into the novel. The
resulting whimsical feel stands apart from the average sleek cosmetic packaging. Bauhaus inspired Simple,
strong, graphic pattern typifies this trend direction, inspired by the purism of the Bauhaus aesthetic and its
emphasis on straight edges and smooth, angular forms. Bold, playschool-style triangles, circles and hexagons
suggest a cohesive and clean brand message. Block shapes replace linear patterning, suggesting clarity and
authority in tone of voice. A clean, simple colour palette in which black acts as an important accent bouncing
off bright, saturated primary red, turquoise and yellow, makes for a youth-inspired combination. As seen in the
work of Ryan Atkinson, the layering and segmentation of shapes to form abstract typography heralds a more
sophisticated take on the recent Nu Rave typographic trends, fusing elements of 80s graphic design with
Bauhaus Modernism. With similar reference to a love of 80s and 90s design, Polish design studio Peak21 has
developed a trademark confident graphic style based around the deconstruction of bold, geometric shapes,
resulting in the creation of minimalist, reductionist and clean-yet-expressive graphic communication. True
authentic We have recently witnessed a renewed motivation amongst consumers to support independent
producers, makers, craftspeople and artisans, moving against ubiquitous, mass-manufactured products. To
launch a small batch of bottles of Balvenie Forty single malt scotch whisky, Here Design collaborated with
cabinet-makers, engravers and calligraphers to create packaging that reflects the quality and craftsmanship of
the product. Meanwhile, American print designer Karl Durrie set up Type Truck â€” a travelling letterpress
print shop to spread the word about the beauty of printing the old fashioned way. Hoping to communicate
notions of utility and fitness for purpose, Swedish studio Planet creative employs several nostalgic materials
and processes in its identity design for clothing brand Another Shirt Please. Subtle graduations of texture and a
soft, soothing palette exude calm, elegance and a smooth modernity. The resulting aesthetic is clean and
thoughtful, as conveyed in the work of Spanish graphic design agency La Caja De Tipos. Their recent
publication Janzkera 10 features a subtle stitched cover pattern, the textured detail providing a more intimate
and tactile experience. Bold photographic content set against full-bleed pages of colour in a palette of dusky
pinks, pale aqua and pigeon grey creates a sense of calm. Gradations of colour and minimal, bold graphics
create a pleasing contrast against 18th century Didot-inspired fonts. These in turn give a nod toward tradition,
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heritage and quality. Retro chaos The celebration of glitches, failures, errors and mistakes is driving a new
style direction in graphic design. Designers are embracing chaos in their creative practices, and as a result we
can see the rise of a growing trend towards an intentionally chaotic and confusing visual language. Aiming to
reflect the handmade elements of the wine, the studio utilised tools such as Wordart, Excel and clipart,
creating retro-inspired graphics. Nostalgia is not the only driver for this trend. Monochrome clarity Simplicity
reigns within communication design while packaging takes a sober turn, adopting a no-nonsense approach to
attract a choice-weary consumer. Limited colour palettes, and bold typography with little ornamentation and
patterning, offer clarity in a sea of choice. They provide a sincere tone of voice that suggests a considered
product of value lies within. Unfettered sans-serif fonts suggest clarity and strength, while confident use of
negative space creates a fresh, authoritative brand image. Devoid of any decoration or superfluous detailing,
simple messages are communicated without frills or fuss. The monochrome colours combined with the Orator
font reference the kind of utilitarian infographics usually associated with import and export.
Chapter 5 : Micro-Design Inc. | Innovative Design, Integration Services and Products
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